Welcome to Paladin!

Thank you for purchasing Paladin POS! We look forward to a long term working relationship with you and your staff.

We trust you will find your new Paladin POS system stable, reliable, and extremely user friendly.

Please take a moment to look at the enclosed guidelines for owner-installed systems and follow them as closely as possible. The closer your installation matches our standards, the cleaner and easier the entire installation will go, and the better your new system will perform.

Paladin’s Account Managers can help you get your system set up and running correctly. Please don’t hesitate to contact your Account Manager for assistance.

Note: Account Managers do not work on Friday.

**Account Managers:**

- Chad Klein 800-725-2346 ext. 7006  chadk@paladinpos.com
- Tyler Klein 800-725-2346 ext. 7014  tylerk@paladinpos.com

Thank you. We appreciate your business.

Sincerely,

**Paladin Data Corporation**

3020 NW Merchant Way  
Bend, Oregon 97703  
Phone: 800-725-2346  
Fax: 541-383-3887  
[www.paladinpointofsale.com](http://www.paladinpointofsale.com)

Updated 12-Apr-16
Setup Guide

Each store’s installation of Paladin POS is different. The following is a general guide to the process of getting your store set up with Paladin POS. If, at any point, you have questions, problems or concerns, contact your Account Manager. They are available Monday through Thursday to assist you with this process.

Caution: If you have an existing POS system, keep it running until you “Go Live” with Paladin POS. Also, you may want to refer to past Accounts Receivable invoices in the prior system.

Section 1: Set up Paladin Network, Terminals and Hardware

1. Notify your Account Manager once you have received your equipment from Paladin.

2. Set up network switch – Open the Network Switch in Box #1 (if provided).
   Note: Depending on your network needs, a switch may not have been included in your hardware shipment. If so, skip to the next step.
   - Mount the switch close to your Cable/DSL modem and router in an accessible place so the status lights are easy to see.
   - Plug a Cat5 network cable from the router to Port 8 on the network switch (refer to the Network Setup Diagram on page 3).
   - Tie up extra lengths of wires and cables and keep them as tidy as possible.

Correct setup

Incorrect setup
Network Setup Diagram

This is a typical network setup for a store with a high speed internet connection. The equipment shown is for informational purposes only, and your modem and router may be different from those pictured here.

Network Switch
The network switch may be supplied by Paladin. It links all the terminals in your stores and supplies the internet connection from the router.

Router
The router is supplied by your internet service provider (ISP). It routes the internet signal between the modem and the network switch.

Modem
A DSL or cable modem receives an internet connection and is supplied by your ISP. DSL modems may have built-in routers.

Important note: DO NOT change the networking configuration on any of your Paladin POS terminals. Should you require Paladin to restore them, you will be charged a service fee.
3. **Set up Terminal 1** – Open the box marked T1. This is Terminal 1, the server for your store.
   - Set up the T1 computer, monitor, keyboard and mouse as shown below. Place the monitor and keyboard on the cash drawer and affix with double-sided foam tape.
   - Drill a hole under the cash drawer and route all cables through it, out of sight.
   *Important note: **DO NOT** turn on T1 until you are directed to do so in Step 8.*

4. **Connect Terminal 1 to the power supply** – Every terminal requires a battery backup or a surge protector with an on/off switch easily accessible to the operator. Run the power cable from the T1 computer to the battery backup or surge protector as described below.
   - **Backup battery setup** – We recommend the use of a battery backup device. If your store suffers a power loss, you may lose data and damage computers. A battery backup instantly switches your computer to emergency backup power, protecting your investment and allowing you to work through brief power outages. **HOWEVER, DO NOT PLUG LASER PRINTERS INTO BATTERY BACKUP.**
   - **Surge protector setup** – For easy access, place the computer on the desk (not on the floor) and attach a surge protector.
   
   *Avoid placing the battery backup next to other electrical appliances such as air conditioners, magnetic security devices, electric motors or laser printers. This can cause excessive voltage fluctuations or emit electrical noise, causing your backup battery to fail.*
5. **Plug in the receipt printer and cash drawer**
   - Run the USB cable from the computer to the receipt printer.
   - Plug the receipt printer’s power cable into the power supply.
   - Run the cash drawer cable from the bottom of the cash drawer to the receipt printer (this allows the receipt printer to trigger the cash drawer to open). **DO NOT** plug this cable into the phone line.

6. **Connect the terminal to the network** – Connect a Cat5 cable from the network port on the back of the computer to Port 1 on the network switch. Leave approximately 6 to 10 feet of additional network wire at each terminal.

7. **Test equipment and internet connection** – Power on T1 and allow it to boot up. If ANY warning message appears or any equipment stall occurs, call your Account Manager immediately. Do nothing with the PC while awaiting help. Connect to the internet using Internet Explorer. **DO NOT** proceed until T1 is able to access the internet.
8. **Sign in to Paladin POS** – Your Paladin POS system was shipped with a default password of 1234. Please sign in as “Test Employee” during training. Your Paladin Account Manager will help you set up a management-level account from which you can add the rest of your employees.

9. **Notify your Account Manager when Steps 1-9 are complete.**

---

### Section 2: Customer Training

10. **Train owner/manager**
   - Open Paladin POS. On the Help menu, click Training Videos. View the video demos to learn how to perform basic tasks in Paladin POS.
     - *Note: You will need your username (your email address) and your password (paladin) to access the videos. You will be prompted to change your password the first time you log in.*
   - Complete the Owner/Manager Pre-Live Checklist on page 14.

11. **Train employees**
   - Have each employee view the video demos (Help > Training Videos).
   - Have each employee complete the Training Checklist on page 16.

12. **Schedule trainer** – Call your Account Manager to schedule a training appointment.

---

### Section 3: Install Paladin POS on Existing Computers

*Complete Section 3 if Paladin will be installing Paladin POS on to your existing computers. If you purchased computers from us, Paladin POS will already be installed.*

13. **Upgrade computers as necessary** – Paladin POS requires the following specifications:
   - Operating system: Windows 7, 8 or 10 (Professional version or better)
   - Memory: 2 GB RAM or more
   - All current Microsoft updates

14. **Notify Paladin** – When Step 14 is complete for all computers, notify your Account Manager to schedule a time to remotely install Paladin POS on your computers.
Section 4: Equipment Installation

15. **Set up terminals** – Set up each computer terminal area the same way you set up Terminal 1 (Steps 3-9).
   - Plug the Cat5 network cables from the terminals into the network switch in order (Terminal 2 into Port 2, Terminal 3 into Port 3, etc.).
   - Make sure each terminal can connect to the internet before proceeding.

16. **Install wiring**
   - Plug Cat5 wiring to each terminal and test all cables.
   - Make sure you have clean, grounded power at each terminal.

17. **Configure Paladin POS** – Your Account Manager or Trainer will walk you through configuring Paladin POS using the Setup window.

18. **Test peripherals and printers** – Test every peripheral device (barcode scanners, signature capture devices, credit card processors, and printers) on each terminal.

19. **Site test the RF base and unit** – Site testing your RF base and unit allows you to find the best location for the RF base to maximize the range of your unit.
   - Set up the antenna in a test location. The middle of the ceiling is usually a good choice.
   - Plug the RF base into a power supply. **DO NOT** plug the RF base into the computer during the site test.
   - Turn on the RF unit.
   - Press 4 to enter the RF Site Survey.
   - Take the RF unit to different locations in the store. Press Enter to start the test. Don’t move during the test.
   - The transmissions between the RF unit and antenna are tested. A reading of 80% or more is needed for adequate speed and reliability. If any readings are below 80%, move the antenna and try the test again.
   - Additional antennas can be purchased to increase coverage in your store.
20. **Set up the RF base and unit** – After completing the site test, mount the RF base in the desired location.
   - Connect the power supply to the RF base.
   - Verify where the RF base is supposed to be plugged into the terminal by checking the label on the side of the computer.
   - Power off the computer.
   - Plug a Cat5 network cable from the back of the RF base to the data coupler.
   - Connect the black cable from the serial port on the computer to the other end of the data coupler.
   - Your RF unit ships fully charged. When it needs to be recharged, remove the rubber stopper on the center back section to access the charging port and attach the charger. Replace the rubber stopper when it is not connected to a charger or printer.

21. **Test RF Unit**
   - Power on Terminal 1, open Paladin POS and click Inventory.
   - Click RF Unit or press F10 to open the RF unit controller.
   - Power on the RF gun.
   - Press 1 to sign on, then press 1 for **Overwrite Mode**. If you are able to enter **Overwrite Mode**, you have successfully set up your RF gun.

22. **Set up your portable label printer** – Contact your Account manager to setup.
23. **Set up EDI** – Refer to the instructions below for enrolling in and setting up EDI functionality for your supplier.

## EDI Setup Instructions

### Ace Hardware

- **A. Enroll in Ace Xroads** – Contact Ace Hardware at 800-777-6797 and request enrollment in the Xroads (Crossroads) system.
  - Request *expanded invoices, hotsheets, promotional downloads and high-speed ordering*.
  - Inform Ace you are changing POS systems, and tell them the Go Live date.
  - Ace will provide you with a username and password.

- **B. Contact your Account Manager.** – We will set up and test Ace EDI on your system.

### ...if Ace Hardware with Ace Rewards

- **C. Enroll in Ace Xroads** – Contact Ace Hardware at 800-777-6797 and request enrollment in the Xroads (Crossroads) system.
  - Request *expanded invoices, hotsheets, promotional downloads, high-speed ordering, dynamic promotions/ace rewards “ESAL”, and customer downloads “EHHC”*.
  - Inform Ace you are changing POS systems, and tell them the Go Live date.
  - Ace will provide you with a username and password.

- **D. Contact your Account Manager.** – We will set up and test Ace EDI on your system.

### Blish-Mize

- **A. Request an FTP account** – Contact your Blish-Mize representative and request a FTP account. They will provide a username and password.

- **B. Contact your Account Manager.** – We will set up and test Blish-Mize EDI on your system.
### Cardinal Health

- **A. Request an Axway/Cyclone** – Contact your Cardinal Health representative and request EDI setup (format X12). They will install Axway/Cyclone on your system, test it, and send a sample file to Paladin.

- **B. Contact your Account Manager** – We will set up and test Cardinal EDI on your system.

### Emery-Waterhouse

- **A. Contact your Account Manager** – We will set up and test Emery-Waterhouse EDI on your system.

### HD Smith

- **A. Request an FTP account** – Contact your HD Smith sales representative and request a FTP account. They will provide a username and password.

- **B. Contact your Account Manager** – We will set up and test HD Smith EDI on your system.

### House-Hasson

- **A. Contact your Account Manager** – We will set up and test House-Hasson EDI on your system.

### Jensen

- **A. Contact your Account Manager** – We will set up and test Jensen EDI on your system.

### McKesson

- **A. Contact your Account Manager** – We will set up and test McKesson EDI on your system.
Orgill

- **Request an FTP account** – Contact Orgill at 800-347-2860 and request a FTP account. They will provide a username and password.
  - If your store name begins with A-L, contact Linda Jamison at ext. 6337 or ljamison@orgill.com.
  - If your store name begins with M-Z, contact Brandy Moraseh at ext. 459 or brandy@orgill.com.

- **Contact your Account Manager**. – We will set up and test Orgill EDI on your system.

Rochester Drug Cooperative (RDC)

- **Request an FTP account** – Contact Cory Schlueter at 585-271-7220, ext. 151 or cschlueter@rdcdrug.com and request a FTP account. They will provide a username and password.

- **Contact your Account Manager**. – We will set up and test RDC EDI on your system.

True Value

- **Contact your Account Manager**. – We will set up and test True Value EDI on your system.
  - True Value requires your POS vendor to enroll you in Afaria.
  - True Value will provide Paladin with a 6-digit username and password.
  - Paladin will schedule a time to remotely install Afaria for your store.

United

- **Request an FTP account** – Contact John Bettendorf at 763-550-2599 and request a FTP account. They will provide a username and password.

- **Contact your Account Manager**. – We will set up and test United EDI on your system.

Wallace

- **Contact your Account Manager**. – We will set up and test Wallace EDI on your system.
World and Main (formerly Handy)

- A. **Request an FTP account** – Contact Chris Bennett at World and Main (formerly Handy) at 713-388-3692 and request a FTP account. They will provide a username and password.
- B. **Contact your Account Manager.** – We will set up and test World and Main (formerly Handy) EDI on your system.

---

### Section 6: Credit Card Setup

- 35. **Credit card configuration** – Do not connect any credit card equipment until you talk with your Account Manager, who will help you configure credit card processing.

---

### Section 7: Pre-Live

- 36. **Confirm completion** - Confirm all previous steps, the *Owner/Manager Pre-Live Checklist* on page 14, and the *Training List* on page 16 have been completed.

- 37. **Schedule Pre-Live** – Call Paladin to schedule Pre-Live at least three business days prior to Go Live. Usually, the Go Live date should be the last order day generated by your old system. This allows time to pull data from your old system and load it to Paladin POS before the next order day. Go Live will only be scheduled Monday-Thursday.

- 38. **Data Verification** – The data must be verified before the store goes live.

  **Inventory Module** – Features include Costs, Retail Prices, Description, Minimum Order Quantity (Order Quantity), Supplier Ratio, Manufacturer Number, and other selections.
  - Configure all items that you purchase by the spool and sell by the foot (wire, chain, rope, etc.)
  - Configure or validate all quantity discount breaks in the Inventory.
  - Set up one dump SKU per department.
  - Run inventory reports to validate inventory data.

  **Customer Module** – Features include Addresses, Phone Numbers, Tax Exempt Accounts, Email Addresses, Credit Limits, Pricing Plans, Authorized Signers, and other selections

- 39. **Configuration**
  - Make sure all employees have a login and password in the *File/Setup/Employee* tab.
  - Add the logo to the receipts and statements under the *File/Setup/Forms* tab. The logo must be in JPEG format, the width must be 450 pixels, and the height must be 110 pixels.
- Set up Sale (Promotions) in the File/Setup/Sale List tab.
- Activate sales in the File/Setup/Pricing Plan tab.

40. **Invoicing** - Enter any stored quotes or special orders.

## Section 8: Go Live

41. **Store goes live** – Paladin has dedicated support staff available Monday through Thursday to assist your store on your Go Live Day.

42. **Update data** – If you purchased Data Capture, Paladin will update Paladin POS with the data from your old system within four business days of the Go Live date.

*Congratulations! Your installation is complete!*
Owner/Manager Pre-Live Checklist

System Overview
- Verify you have received training on the Paladin File > Setup tabs.
- Log in and log out of Paladin POS. The number key lock must be on to sign in.
- If you are not using a mouse, make sure you know how to use the Page Up & Page Down keys to move between the large tabs at the top of the screen, and how to use the Tab key to move around the fields. You can select modules with Alt # keys and select commands with F # keys.

Configuration
- Add your logo to receipts and statements. Go to customerportal.paladinpos.com, log in, and click Knowledge Base. Type “Adding a logo to receipts and statements” in the search box and locate the article under Search Results.
- Build and test a dump SKU for each department. Refer to Knowledge Base article 03693: Setting up a dump SKU.
- Build tax structures for non-taxable accounts and inventory items.
- Set up sales: Open File, click Setup. In the Paladin Configuration window, click the Sale List tab.
- Activate sales: Click the Pricing Plan tab.
- Employee Setup?
- Printer Setup in the Network tab?
  - Laser Printers
  - Receipt Printers
  - Bin tag Printers
- Have you gone through the Company tab?
- Have you gone through the Forms tab?

Invoicing
- Recall at least 100 unique items at POS. Verify UPCs, prices, and descriptions are correct.

Inventory
- Run Inventory reports and Stock Value reports to ensure that the numbers seem reasonable. Pay special attention to any negative margins, and fix the prices before going live.
- Review a few inventory items to ensure they are correct.
Set up and test quantity pricing.

**Customers**

- Review names to make sure you can find customers easily. Standardize on either Fname/Last or Last/Fname.
- Review customer accounts for pricing plans, trade discounts, store accounts, etc.
- Set up credit limits, prompt payment discounts, authorized signers and POs (if required).
- Review tax status. Make sure taxed customers are taxed and non-taxed customers are not.
Training Checklist

Invoicing
- Sales made with different payment types
- Returns / defective returns
- Price overrides
- Advanced lookup
- Paid in / paid out *
- Special orders *
- Create / save / recall a quote *
- “On hold” orders
- Recall an invoice

Customers / House Accounts
- Add / remove / rename customer accounts
- Adjust credit limit
- Receive payments
- Understand different accounting types
- Discounts / prompt payments *
- Set up taxes for each customer
- Set up Rewards *

Inventory
- Add / remove / rename inventory items
- Pricing adjustments
- Manage stock on hand counts
- Shrinkage
- Order control
- Bin tags *

Reports
- Month end statement
- Accounting summary report
- Daily balancing report
- Comparative revenue report
- Transaction report
- Suggested order report

Purchase Orders *
- Create / receive / adjust a purchase order

EDI *
- Send / receive a purchase order via EDI
- EDI processing settings

RF Unit
- Overwrite stock on hand (SOH)
- Append SOH
- Build a working purchase order (PO)
- Receive stock

* If applicable
Paladin Support Options

Once you go live, our Customer Support team is ready to assist you with any questions or concerns. Our support facilities are in the United States and all of our support technicians speak fluent English. Your call will be answered by a human being and you will never be on hold for long.

Priority Support

Normal support hours are Monday-Friday, 8 AM to 8 PM Eastern (5 AM to 5 PM Pacific), excluding major holidays.

For the best response times to technical support inquiries once you go live, follow these steps:

1. Open Paladin POS. On the Help menu, click Open a New Case. You will automatically be logged into New Case.
2. Type a few words in the Title.
3. Select a Case Type.
4. Click Create A Case. You are now next in line for call back.

Alternately you can login to the Client Portal and create, view or update a case. To access the Client Portal go to customerportal.paladinpos.com/login. You may also email support at support@paladinpos.com or you may call 800-725-2346 press 2 and follow the prompts.

Emergency After-Hours Support

Emergency After-Hours Support is provided for “store down” emergencies, via phone, occurring outside of Paladin’s normal business hours. If your issue is considered a non-emergency, you will be referred to Priority Support on the next business day.
Emergency After-Hours Support is only staffed outside of normal business hours. All calls are handled by Priority Support during normal business hours. Emergencies during normal business hours receive top priority. Please use option 2 when calling the 800 number and follow the prompts.

Cases created online with the word “Emergency” in the title during normal business hours will receive top priority also.

Emergency After-Hours Support is available 365 days a year, 24 hours a day during any hours where Priority Support is not available.

To reach Emergency After-Hours Support, call (800) 725-2346 press 2.
Customer Data
- If you purchased Data Acquisition and/or Data Load from Paladin, Paladin will load the database information into your new Paladin POS system, if not done before shipping.

Customer Training
- All training videos must be watched by all employees:
  - Paladin training may be scheduled immediately after receiving your server.
  - Your Account Manager will help schedule your training.

Remote Builds of Customer Machines
- Customer installs 2 GB RAM, updates all MS Service Packs and .NET libraries.
  - Notify Paladin when complete on all PCs.
  - Paladin will start remote builds within 7 business days.

Customer Install
- Customer installs Paladin supplied equipment. Setup terminals, install and test Cat5 network cable and test every peripheral on every machine.

Vendor Data Catalogs
- Customer contacts vendor for catalog and sends vendor data to Paladin.
  - Paladin will perform conversion within 7 business days.
  - Paladin loads new catalog into the system remotely.

Credit Card Setup
- Is your processor listed on the “Accepted Processors” sheet?
  - If no, call Vantiv. If yes, complete ALL fields on the setup sheet and fax.
  - Paladin configures credit card processing within 7 business days.

Vendor Communication Setup
- Enroll in or subscribe to your supplier’s EDI communication system.
  - Call your Account Manager for configuration and testing.